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COBOL Standards Checking — RDz's “Code Review”
Featfure — Part 2

This article is the second in a two-part series that explores the use of RDz’s “Software Analyzer” for
analyzing COBOL** Performance and Maintainability.

By Chris Leland, Royal Cyber

ast issue we infroduced you to RDz's Software Analyzer/Code Review feature — which provides an

automated approach to COBOL, PL/I and Java standards checking for performance. In the last issue we
discussed how important standards checking was — especially for reviewing ways to optimize your COBOL, PL/I
and Java source. In this issue we will finish off code review by discuss three topics:

1. Parameter Driven Rules Customization
2. Batch Code Review Execution
3. Completely Custom Rules

Full disclosure, in this issue we will focus primarily on Parameter Driven Rules and Batch Execution. Completely
Custom Rules development and deployment is a huge topic, and probably best learned by ufilizing expert help.
Royal Cyber specializes in developing custom code review rules - and you can learn more about what we've
done and see a few samples by checking out our offerings on the EM App Store; http://www.royalcyber.com/em-

app-store/

Parameter Driven Rules Customization

The out-of-the-box default (IBM-supplied) come in two flavors — 1. those that check for the existence or non-
existence of something in your code you want highlighted when running Code Review — and 2. Code Review rules
that require you to define parameterized input to the rule. The first category was covered in the last issue — so
please refer to Newsletter Four — for details.

The second category (parameteter driven rules) is accessed from: Window > Preferences > Software Analyzer >
Custom Rules and Categories — as shown in figure 1 below.

From this dialog you can see that you can:

o Define new Categories — to organize your rulesets by — well — anything that would be meaningful; Business
Areas, Technologies (Hogan COBOL Rules, DB2 SQL Rules, etc.)

o Define new Rules — which extend the standards rules for COBOL, PL/I and Java we looked at in the last
issue.

Defining new Categories
Adding a new custom ruleset is a simple a matter of Clicking:

e Selecting a language and clicking; Add Category...
¢ Typing the Category name into a dialog (see figures 2 and 3 below).

You can see from the screen captures that any named rule (including rules with special characters) are allowed.
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type filter text Custom Rules and Categories Peooew
. E::m‘:ﬁ?;:r I Create or remove custom rules and categories. Custom categories can only be removed if they contain no child categories or
rules.

» Help

. IBM DB2 Analytics Accelerator Current Custom Categories

» Importer 4 5 COBOL Code Review Add Category...
> Install/Update - (2 PROCEDURE DIVISION Rules = =

> Java - (2 SQL Performance Rules welete Lategory
» Java EE

+ JavaScript

+ JCL

+ JET Transformations

+ LPEX Editor

» Measured Improvement

» Menu Manager

» MFS Editor

+ Model Validation

- Modeling

» PLA

> Plug-in Development

» Problem Determination Tools

. Profiling Current Custom Rules

Remote C/C++ 4 5 COBOL Code Review M Add Rule...
» Remote Makefile Editor = 4 ( PROCEDURE DIVISION Rules lag - -
Remote Synchronization [2] An inline PERFORM statement cannot exceed the specified line HElEte nue

» Remote Systems & Awvoid nesting IF statements deeper than the specified number ¢

+ Report Design & Procedure division statements cannot exceed the specified line

> Run/Debug 4 (@ SQL Performance Rules

+ Server [ EXEC SQL: Use a WHERE clause in selected statements

» Service Component Architecture 1

4 Software Analyzer

Custom Rules and Categories
> Team

Figure 1. The Software Analyzer Custom Rules and Categories dialog

Defining new Custom Rules
Adding new rules is a 4-part process:

1. From Custom Rules and Categories click Add Rule... Figure 1

2. Select the (Parent) Category the new rule belongs to — note that you can add new Custom Rules to any
category, not just new Custom Categories - Figure 4

3. Define the parameters for the Custom Category (Figure 5) and select the severity to assess for breaking the
rule (Recommendation, Warning or Severe) — Figure é

4. Add new Parameter Driven rules to an existing Ruleset — Figure 7.

Note from Figure 5 that there are quite a few high-value Parameter Driven rules — for COBOL, such as:

e Detfermining an acceptable level of IF Nesting and Inline Perform

¢ Cafching specified SQL statements that do not have a WHERE clause
e Finding Paragraphs and Sections that are not commented

e Enforcing naming conventions for conditionals and file names

Similar quality Parameter Driven rules exist for PL/I and Java.
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Delete Category

»

4|57 COBOL Code Review nd
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- @ Maming Conventions
. @ Performance
+ 2 PROCEDURE DIVISION Rules
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: @ SQL Performance Rules
4 4 Java Code Review
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+ 2 Naming
- @ Performance
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+ 2 Security Delete Rule
4 5| PL/T Code Review
> @ Naming Conventions
. @ Performance
: @ Program Structures

1

Add Rule...

Figure 2. Adding a Rule Category - part 1

r‘) Add Custom Category [ - | = |_ _J

Enter Category Name

Enter the name for the new category

MName

Group Claims (Specific COBOL Rules)

@j MNext = l Finish L\‘J l Cancel

Figure 3. Adding a Rule Category - part 2
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@

4 B
: (2 Enterprise COBOL

COBOL Code Review

2 Group Claims (Specific COBOL Rules)

» 2 Naming Conventions

. @ Performance

- (2 PROCEDURE DIVISION Rules
. @ Program Structures

- 2 SQL Performance Rules

=l Java Code Review

- (2 Design Principles

: 2 Globalization

- (2 J2EE Best Practices

. (@ J2SE Best Practices

N B R

Finish

111

Cancel

Figure 4. Adding a new Rule - part 1

While everything is not shown above — Figure 4 describes

the RDz Custom Rules Categories:

e Language (COBOL, Java and PL/I):

o Existing Ruleset categories

o Any custom Ruleset categories you've defined
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Select Template

Select a template to use for this rule

»

%= An inline PERFORM statement cannot exceed the specified line number limit
= Avoid calling the specified routine

= Avold including the specified copy book

= Avoid nesting IF statements deeper than the specified number of levels

= Avoid static calls except for the specified program name

= Avoid using the selected compiler directives

2 EXEC SQL: Use a WHERE clause in selected statements

%~ Follow the specified naming convention for COBOL file names

%= Procedure division statements cannot exceed the specified line number limit
|-T- Use a scope terminator phrase with the specified COBOL,statement type|

%2 Use comments to describe all paragraphs

%= Use comments to describe all sections

%2 Use the specified prefix with condition names B

11

@ [ < Back “ MNext = ] Finish

Figure 5. Adding a new Rule - part 2

R —
@ Add Custom Rule | (=] g

Assign Template Values

Fill in the values associated with this template

IF requires END-IF

[C] EVALUATE requires END-EVALUATE
READ requires END-READ

[] SEARCH requires END-SEARCH
STRING requires END-STRING

[C] CALL requires END-CALL

Severity:

»

m

Recommendation

Recommendation I
Warning

Severe

The severity assigned to violations of this rule ST

® Mext > [ Finish ] l Cancel

Figure 6a. Adding a new Rule - part 3
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Figure 6b. Parameter driven rule added

\-4 Software Analyzer Conﬁguraﬁmm » M
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4 5 Software Analyzer
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4 Development Rulesets
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4| Production Level Rules

% QA Code Review Level Rules “ f“ COBOL Code Review [20/50]
» [ ]2 Enterprise COBOL [2/2]
4 L’a’ Group Claims (Specific COBOL Rules) [1/1]

& Use a scope terminator phrase with the specified COBOL statement type
» [#]c2 Naming Conventions [1/1]
» |2 Performance [5/9] _
2 PROCEDURE DIVISION Rules [3/3]
g L’a’ Program Structures [7/33]

=l b e .

Properties

IF requires END-IF

[] EVALUATE requires END-EVALUATE
READ requires END-READ

[ SEARCH requires END-SEARCH 4
STRING requires END-STRING

[] CALL requires END-CALL i

»

111

»

111

Filter matched 5 of 5 items l Apply ] l Revert ]

@ [ Analyze ] ‘_EfCIO% ]

A po

Figure 7. Adding a new Rule - part 4

From Figure 7 you can see that, after editing the Software Analyzer Configuration, you can select your new
Parameter Driven Rule(s) — and Rule Categories. After you've selected the rules you want to run against your
code: Click Close, and at “Save changes?” click: Yes.
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(Review) Running the Code Review Rules

When you've saved your changes and are ready to run (again - assuming that you're in Edit) select:

Software Analyzer > Claims Processing Rules (or the name of your Configuration)

This will invoke Code Review on your program. Code Review analyzes your program and flags any statement that
violates one or more of the rules you've selected with a Code Review annotation (see Figures 11 and 12).

B MTCHMERG.cbl I = B | # Remote Sys.. = \DE: Perform Hie... 4 Search  ®Systems |
- I T N . £ 21|
ARAARA 1A FETLIER PIC X(2). - . & New Connection
€ Save Ctrl+5S . Ef Local
E cut Cur=x Eig iﬁ; "VALUE SPACE. + ™ Development (demornvs)
E Copy Ctrl+Insert PIC X(2). » Ty z/OS UNIX Files
€ Paste Shift+Insert [% 2/0S UNIX Shells
€ 3 4 T MVS Files
Select 4 =ig 4., )
€ PIC S9(7) COMP-3 VALUE ZERO. - i Retrieved Data Sets
w g  Selected " | PIC 59(8)v9e COMP-3 VALUE ZERO. . % My Data Sets
€ Deselect Alt+U PIC S9(7) COMP-3 VALUE ZERO. . & My COBOL & COPYBOOKS
4 E Filter view 3 E%E :g E%V% Egﬂﬁj :ﬁtﬂg %Eﬁg > 3=35 My Team's COBOL
w g Showa Cul+W | pIc s9(8)V99 COMP-3 VALUE ZERO. 3¢ My JCL Datasets
€ Source v | PIC S9(7)  COMP-3 VALUE ZERO. ¢ My REXX Execs and CLISTS
(L Prene ey ST R PIC S9(8)Vv99 COMP-3 VALUE ZERO. 4 :TD Kevin's Stuff
€ PIC S9(7) COMP-3 VALUE ZERO. > & BMS and MFS Maps
w ¢ Refactor * | PIC $9(8)V99 COMP-3 VALUE ZERO. > . % System Assembler MACLTBs
Occurrences in Compilation Unit Ctrl+Shift+R . % 5y51 datasets
Open Declaration F3 - , %% RATRDZ.VORO.*
Open Perform Hierarchy
& Re View v parch 48 Remo.. Efi Comp... f& Sing By Remo.. EISQLR.. B Remo... & Fault ... EX demo... 57 Softw... & |& SQL.
Show In L4
|  OpenWith ' COBOL Code Review
3 Run As b ) 633ms]
Debug As 4
Profile As 4 4|2 Group Claims (Specific COBOL Rules) [19 results in 138ms]
Validate > & Use a scope terminator phrase with the specified COBOL statement type [19 results in 138ms]
Software Analyzer L4 Software Analyzer Configurations... 2 Performance [9 results in 224ms]
Team - L3 'l Claims Processing Rules [, » [1] Use an odd number of digits in a CQMP-3 or PACKED-DECIMAL data definition [9 results in 210m
Compare With 3 Development Rulesets Iy 2 PROCEPURE pNISION Rules [3 results in 25ms] - ]
Replace With » Production Level Rules - @ Avoid nestlnrgVIFV statements deeper than the specified Vnrumbrer of levels [? rgsults in lftms]
Asset Analyzer 3 QA Code Review Level Rules > & Procedure division statemer?ts cannot exceed the specified line number limit [1 result in 8ms]
Start Flagging Changed Lines 2 Program Structures [41 results in 300@5]
+ 1] Avoid GO TO statements [2 results in 14ms]
Preferences... - [1] Avoid IF without ELSE [9 results in 63ms]
Local Syntax Check (Deprecated) Ctrl+AltsL + 1] Avoid NEXT SENTENCE phrases [1 result in 8ms]
+ 1] Avoid THRU phrases in PERFORM statements [29 results in 207ms]
Open Copy Member
L Browse Copv Member

Figure 11. Rule Violation annotations — and hyperlinks from a COBOL Code Review view

Running Code Review against an entire PDS in one action

Interactive Code Review runs locally against individual programs opened in either the LPEX, COBOL, PL/I or Java
editors. However, it can also run against an entire TSO library (PDS) if you download the library to a Local
Workstation Project (you can drag & drop or copy & paste). This will create a folder in your Workspace. You can
then Right-click over the entire folder, and from the Context Menu select: Software Analyzer and the Ruleset you

wish to run against the PDS (See Figure 12).
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&) PATLIST.cbl New '
&) PATSRCH.cbl [ Rename..
m| PrintApp.cbl = Copy
=] RESPXMPL.chl Move...
{I&5 RTPOT73.0EMO.COBO| = paste
& SAM1.chl | % Delete..
= SAMI1V.cbl B’ Search.
ol SAM? rhi
I #| Refresh
B Data .. 5= Outline &2 Show in Remote Systems view
Run As *
t available. Debug As '
Profile As ¢
Team ' Jrope... B4 Snipp.. 3 Search #8Rem
Compare With r

Restore from Local History... Launch Date

Asset Analyzer ¢ |

743 May 20, 2014 10:13:16 AM
Source 61 Apr 25,2014 10:14:28 AM
o 512 Apr23, 2014 8:27:04 AM

Import z/OS Project... Software Analyzer Configurations...

- , Claims Processing Rules
Development Rulesets

m Open Welcome Page Production Level Rules

Software Analyzer v QA Code Review Level Rules [

Figure 12. Running Code Review on an entire PDS (source library)

Batch (JCL-driven) Code Review

Code Review prior to RDz v9.0 was both interactive, and based on the West Point “honor system™ —in that, if your
program statements broke a Code Review rule you might (or you might not) be interested enough in the results to
change code that is flagged. In other words there was way to enforce conformity to standards. Also Code
Review prior to v9.0 was entirely an IDE-based/manual process, and many shops these days are looking forward
towards the “continuous delivery” app-dev model — where, as part of a check-in and Build process, Code Review
iruns and reports are generated showingi the general health of the program and level of standardization
achieved. Enter RDz v9.0 and Code Review running in Batch.

Starting in Q3 / 2013 RDz's v9.0.1 allowed Batch-driven Code Review — where a REXX is called from MVS JCL and
the REXX in furn access various z/OS UNIX files. IBM ships a PROC for this; AKGCR — which ships in the
AKG.SAKGSAMP files. Your Systems Programmer will have to decide how to configure the samples for this as
AKG.SAKGSAMP is typically not in JES’s default search path.

The REXX returns a single over-loaded MVS Return Code (see Figure 13) that describes both the status of the process and
the highest Code Review error level (read the comments from the PROC to ascertain what happened during the run).
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/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*
/1*

1%

The tool can end with following return codes:

- a:

processing completed successfully

there are no code review rule violations

the generated code review output is valid

the (optional) post-processing script executed successfully

: processing completed successfully

the most severe review violation is a recommendation (4)
the generated code review output is valid
the (optional) post-processing script executed successfully

: processing completed successfully

the most severe review violation is a warning (8)
the generated code review output is valid
the (optional) post-processing script executed successfully

: processing completed successfully

the most severe review violation is a severe violation (12)
the generated code review output is valid
the (optional) post-processing script executed successfully

: warning, non-critical issues were encountered

the state of the code review violations is unknown
the generated code review output is valid
the (optional) post-processing script executed successfully

: the most severe post-processing message is a warning (4)

the state of the code review violations is unknown
the state of the generated code review output is unknown

: the most severe post-processing message is an error (8)

the state of the code review violations is unknown
the state of the generated code review output is unknown

: the most severe post-processing message is a failure (12)

the state of the code review violations is unknown
the state of the generated code review output is unknown

: error, critical issues were encountered

the generated code review output is not valid

: system or environment error

the generated code review output is not valid

Figure 13. Batch Code Review MVS Return Codes

Running Code Review in Batch
To run Code Review from JCL you need to (minimally):

Find and customize the AKGCR JCL PROC (see Figure 14)
Find where your Java home_directory is under UNIX z/OS
Transfer your Code Review Rules to z/OS UNIX:
o Export the Rules to a PC File
o Import the Rules to a Local Workstation project
o Drag & Drop the Rules to a z/OS UNIX directory where you have R/W access
Transfer your Property Group file to z/OS UNIX:
o Export the Property Group to a PC File — ending on .xml
o Import the Property Group file fo a Local Workstation project

o Drag & Drop the Property Group file to a z/OS UNIX directory where you have R/W access

K K K ¥ K K K K K K K K K K K K ¥ K K K K K K K K K K K K K K K K K
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Over-ride and/or validate DD statements in the AKGCR Proc for:

e JAVA

e PDS - which names the program you wish to run Batch Code Review against
e RULES - point to the UNIX directory where you've fransferred your custom rules
e PROPERTY - point to the UNIX direectory where you've fransferred your Property Group

AKGCR

/1*
AKGCR
SYSPROC
SYSTSIN
SUMMARY
Ccsv
XML
WORKSPCE
M5GS
ERRMSGS
PM5GS
PERRMSGS
PATH
SYSTSPRT
PD5
MEMBERS
HOME
JAVA
TMPDIR
RULES
CUSTRULE
PROPERTY
EXTMAP
SCRIPT
OPTIONS

Figure 14. Batch Code Review MVS Return Codes

PROC PRM="",

EXEC PGM=IKIEFTO1,REGION=0M,PARM="%AKGCRX &PRM'

DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD
DD

-

PATH="/rc/v9@/usr/lpp/rdzutil’,
RULE='/shared/test/cr',
HLQ="RC@a1’

DISP=SHR,DSN=&HLQ. . SAKGPROC

DUMMY

SYSOUT=*,RECFM=VB, LRECL=2@51
SYSOUT=*,RECFM=VB, LRECL=2@51
SYSOUT=*,RECFM=VB, LRECL=2@51
SYSOUT=*,RECFM=VB, LRECL=2@51
SYSOUT=*,RECFM=VB, LRECL=2@51
SYSOUT=*,RECFM=VB, LRECL=2@51
SYSOUT=*,RECFM=VB, LRECL=2@51
SYSOUT=*,RECFM=VB, LRECL=2@51

DUMMY SYSOUT=*,RECFM=VB,LRECL=2851
SYSQUT=*
DISP=SHR,DSN=RC@®®1.TEST.COBOL (WARDRPT)
DUMMY

PATH="8&PATH. '
PATH="/usr/1lpp/java/16.0"

PATH="/tmp"
PATH="/u/rc@eel/claims_rules.dat’
PATH="&RULE. fcustom.rules.ccr'
PATH="/u/rc0Bel/db2work.xml’
PATH="&RULE. fextension.mappings.zip'
DUMMY PATH='&PATH./samples/cr.post.sh’
DUMMY *

- a

* input overrides

z/0S 1.13 supports instream data in PROC

There are many additional options for running Batch Code review — including the integration or use of your own
Custom-created Code Review rules (next topic in this Newsletter), reviewing multiples PDS members in one run,

providing the Batch process with custom z/OS File System Mapping and others described in Figure 15.

//* SYSTSPRT
//* - DD definition only

//* - holds the log of the tool that triggers the code review

//*
//* PDS

TSO output, required

PDS holding source, required
//* - when concatenating multiple DDs, only the first one is used

//* - must reference a PDS(E)

//* - when DSN(MEMBER) is provided, and MEMBERS is empty, then

//* MEMBER will be used as member filter

/7*
//* MEMBERS

member filter, optional (all)

//* - when concatenating multiple DDs, all are used
//* - comma separated list of members to review

/7*
//* RULES

*.dat, validation rules, required
//* - when concatenating multiple DDs, only the first one is used

* ¥ ¥ X X X X ¥ ¥ X ¥ ¥ ¥ ¥ ¥ ¥
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/1*
/1*
/7%
/7%
/1*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/7*
/1*
/7*
/7*
/7*
/7*
/1*
/1*
/7*
/7*
/1*
/1*
/1*
/7*
/7*
/1*
/1*
/7*
/7*
/7*
/1*
/7*
/1*
/1*
/7*
/7*
/7*
/1*
/1*
/7*
/7*
/1*
/7*
/1*
/7%
/7%
/1*
/1*

Figure 15. Additional DD Card Customization and Options for Batch Code Review

- must

reference a z/0S UNIX file

PROPERTY *.xml, property group, required
concatenating multiple DDs, only the first one is used

- when
- must

HOME
- when
- must

JAVA
- when
- must

TMPDIR
- when
- must

SCRIPT
- when
- must

EXTMAP
- when
- must

CUSTRUL
- when
- must

CODEPAG
- when

reference a z/0S UNIX file

base directory for code, required
concatenating multiple DDs, only the first one is used

reference a z/0S UNIX directory

base directory for Java, required
concatenating multiple DDs, only the first one is used

reference a z/0S UNIX directory

base directory for workfiles, optional ($HOME)
concatenating multiple DDs, only the first one is used

reference a z/0S UNIX directory

post processing script, optional ()
concatenating multiple DDs, only the first one is used

reference a z/0S UNIX file

*.zip, extension mapping, optional ()
concatenating multiple DDs, only the first one is used

reference a z/0S UNIX file

E *.ccr, custom validation rules, optional ()
concatenating multiple DDs, only the first one is used

reference a z/0S UNIX file

E convert UTF-8, optional (IBM-037)

concatenating multiple DDs, all are used

- only first word of provided data is used

OPTIONS
- when

ENVVARS
- when

CFG
- when

SUMMARY

csv

XML

WORKSPC

MSGS

ERRMSGS

PMSGS

PERRMSG

PATH

additional Java startup options, optional ()

concatenating multiple DDs, all are used

additional environment variables, optional ()

concatenating multiple DDs, all are used

alternative method to provide input data, optional ()

concatenating multiple DDs, all are used
content of Analysis Summary.xml,
content of CSV Analysis Results.csv,
content of XML Analysis Results.xml,
E content of workspace.log,
content of stdout.log,
content of stderr.log,
content of post.stdout.log,
S content of post.stderr.log,

content of path.log,

output
output
output
output
output
output
output
output

output

¥ K K X K K X K K K K XK XK X K K K X K X X K X X K XK X XK X X KK X X KK X X K K X X XK K X X KX X XK X X KKK X ¥ X
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Batch Code Review Outputs

Outputs from Batch Code review include Log files and the same CSV (spreadsheet format) and XML output
summaries as are produced. Figure 16 shows a series of XML results which could be input into any XML reporting
product or hardcopy utility.

N
//* invoke code review

fLimitR

structure” name ~am Struct
Rule” name="A 1 NC statements”

ider” name="P

Reports generated are the same
format as reports generated by RDz
workstation client with command line
invocation (XML report shown).

Figure 16. Batch Code Review Output Report - Generated XML

Custom Code Review Rule Development

As soon as IBM announced support for Code Review customers began asking for the ability to “roll their own" —
Custom Code Review Rules. So in v?.0 IBM provided a Java/Eclipse wizard-driven development framework for
creating custom COBOL Code Review Rules — and in RDz v9.1 IBM offered the same sort of process for custom PL/I
Code Review Rules development and deployment. The Custom Code Review Rules are generated as standard
Eclipse/Java plug-ins that must be installed (not copied... installed) info use.

As mentioned at the beginning of this article, this is a deep and complex topic — and set of steps. It pre-req’s both
the target language (COBOL or PL/I) and a deep understanding of how to create and deploy Eclipse/Java plug-
ins. Typically one single person does not have both skills/experience to the technical depths necessary so shops
often pair up a Java/Eclipse developer with a z/OS COBOL programmer to do the work.

And as mentioned earlier, Royal Cyber has a year+ of experience doing this work. It would make sense if you're
interested in this — fo contact us and find out how we can jumpstart your efforts: http://royalcyber.com/em-app-
store/custom-cobol-code-review-plug-ins/
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Next steps...

RDz is one of the primary strengths of Royal Cyber. In 2014 IBM chose Royal Cyber to manage its RDz “Distance
Learning” program - out of all the RDz business partners world-wide. We offer deep and quality service
engagements in every phase or RDz — from Installation and Deployment, to Training/Mentoring and adoption, to
administering and supporting both the RDz client and server — and finally, fo evaluating your RDz Adoption and
Return-on-Investment.

e For details on the Royal Cyber RDz Rollout and project/task usage modeling contact us: inquires@royalcyber.com
e To sign up for Royal Cyber RDz Free Distance Learning: http://royalcyber.com/royal-cyber-rdz-distance-learning-training-

schedule/
e To get acopy of the January 2014 Newslefter —including additional deep-dive articles on RDz and RAA::

http://royalcyber.org/mn/index.html

Chris Leland: chris is Royal Cyber’s primary RDz technical instructor - having worked full-time with RDz for
almost four years; developing applications in COBOL, teaching RDz classes and mentoring in COBOL and
Assembler, installing and configuring RDz, delivering custom workspace design sessions, writing an RDz evaluation
exam, and infegrating RDz with Rational Asset Analyzer. Chris passed the IBM/RDz Certification exam with flying
colorsin 2011.
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Where in the world is my RDz Plug-in?

Finding that elusive plug-in for RDz

By Bill Napolitano

Lately we've gotten a number of requests by customers to pull fogether a table of RDz plug-

ins and where to get them. Done. In the table below you will find RDz plug-ins from IBM, from

Compuware and from CA. We do not claim that this table is complete — nor can we be 100% certain that every
plug-in listed will work with your version of RDz. As one of my COBOL instructors once told me about the
importance of testing, “It works when it works.” As bromides go ... not bad.

Plug-in Vendor RDzversion Comments
This plug-in automates the tedious, time-consuming and error-prone
Property Group Royal Cyber | V8.x
process of creating the SYSLIB entry for the RDz editors. It solves one
Cc
Lot V9.x of the most challenging aspects of rolling out RDz successfully.
RAAi IBM RAA vé.x This plug-in to RDz allows you to access the full capabilities of RAA
for application analysis from inside RDz. See the Royal Cyber
RDz v8.5 and Newsletter #2 for details: http://webspherehatsguru.com/Royal-
v9.x Cyber-Development-Modernization-Newsletter-Volume1-1.pdf
The plug-in is part of the RAA DVD set. You can also obtain it
through the standard IBM support site.
Debug Tool ** No plug-in IBM All releases No plug-in is necessary. This functionality ships with RDz
is necessary. This
functionality ships with RDz
PD Tools plug-ins: IBM PD Tools v13.1 This link is to the Installation Manager
e File Manager RDz v8.5
e Fault Analyzer Note - if you are using RDz v8.5 and/or PD Tools v12 or vi1 go here:
e Application RDz v9.x http://www-01.ibm.com/support/docview.wss?vid=swg24036304
Program Analyzer
e CICSTools
CA-Intertest Computer Unknown You will have to get this plug-in from your Computer Associates
Associates sales-rep. It is not available for download.
Compqure Suite: Compuware | RDz v8.x You will have to get this plug-in from your Compuware sales-rep. It
is not available for download.
e Xpeditor RDz v9.x ) o )
File-Aid If you need assistance with this, please contact Jim Ixxx from
‘ fle-Al Compuware.
e Abend-Aid
You will have to get this plug-in from your Compuware sales-rep. It
Serena Changeman erena V8.5
. is not available for download.
LMF Client Pack V9.0
CA-Endevor plug-in Computer V9.0 RDz ships with a free framework for integrating with CA-Endevor
Associates called CARMA. But Compuware also ships its own RDz/Endevor

integration software. Which you can obtain from your CA rep.

Bill Napolitano is a freelance technical writer with a 30-year background in z/0S application development

and tooling.
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The RDz Top 10 “How To” and
“Say What?!?!” Mysteries Explained

This article describes the most common issues and answers, and technical “*how to” concerns from new-
to-RDz Users .

By Chris Leland, Royal Cyber

I've been teaching RDz for 3 "2 years — and in that time have seen a lot of reactions, and been asked a lot of questions... some of them
over and over again. So | thought, “Hey Chris... why not get ahead of this? Why not answer questions before they’re asked. So —
taking a page from the Johnny Carson “Great Carnac” routine, here’s a list of the most common RDz questions (and answers):

I. Why is the Perform Hierarchy disabled/grayed out?

e There are typically two reasons this happens:
i. Your program has not been mapped to COBOL (please read up on z/OS File System mapping)
ii. There are syntax errors in your code that are so severe the RDz parser can’t make sense of the semantics of
your PROCEDURE DIVISION — and just does a Roberto Duran, “No mas!”
e Next level explanation of the RDz’s approach to syntax checking...
i. The RDz LPEX, COBOL and PL/I editors always maintain two copies of your program:
I.  The code you see (just like ISPF =1 and ISPF =2
2. And a in-memory/parsed version of your program that RDz uses to provide “advanced tooling
features” — such as the COBOL Perform Hierarchy, Program Control Flow diagrams (for COBOL
and now for PL/I), Occurrences in Compilation Unit, Content Assist, etc. etc.
ii. If the in-memory/parsed version of your code contains enough — or certain types of syntax errors (say you
misspell PROCEDURE DIVISION?) — then advanced tooling is turned off — until you fix the syntax errors.
iii. (But what if I'm accessing production code — which does N O T have syntax errors?
I.  Chances are that your Property Group file is not setup correctly;
a. Either you’re missing a SYSLIB entry
b. Or you’ve not mapped the Property Group to the resource you’re working with.
e Thereis a 3™ possibility for this problem — which I've seen in couple of shop’s where they put some kind of flag or
annotation in the PROCEDURE DIVISION telling the build JCL that the program is either batch, online or both.

These kinds of programs needs special handling (see question #9 below).
Editor profile

2. How do I get ISPF functionality during my edit session? e
e To edit your programs using ISPF functionality you must use the LPEX (not COBOL, e
not JCL and not the PL/I dedicated editors) ispf_
[
e Plus you need to make sure that your LPEX profile is set to iSpf siix s

i. From Window > Preferences > LPEX Editor, set the Profile to ispf =

3. Why does RDz hang when | open a dataset (not a source file ... a data/dataset)?

® Most likely you're opening a large QSAM file — right? (RDZ doesn’t edit VSAM or IMS Databases without help from
the IBM File Manager plug-in).

® But (assuming you've said, “yes Chris... that’s it!” — you have to do one more thing to avoid this problem.
® Map the dataset to a Workstation File Extension of tdat

i. From the small picture below you can see that I'm accessing the z/OS File System mapping view (even though
the view’s full name is ellipsed)
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& Rem PX1 t';,' Prope B Cring
ii. From this view you can right-click, and Add a Data Set S Cmd IH z/0S .. % |5& Prope 5 S

Mapping to your DSN — that specifies tdat as the

[
. . : o oA System: | Development (demomvs v
Workstation File Extension (and download the file in binary) X ‘\ P { ¥5) }

e The net results of doing this will be that RDz opens its dedicated Mapping Siterion) Werkstation Fil Extension| Tonster M

QSAM file editor — displaying (by default) 200 records at a clip. DATA 4 Edit nan
. . . X **TEMPLATE tmpl + !
Not hanging — and providing some very nice tooling. MES P LE’LB Add Data Set Mappi
#*AZUCEG azucfq o Add Member Mappi

4. How does Block (rectangle) copy/paste work?
® Block copy works very well if you’re using the new COBOL, |CL and PL/I editors

i. There’s actually a toolbar option to select: “Block Selection Mode” toggling.

JI?@}‘ % v [ Activity: Other Activity v BIS & | | & = | iy v Al v v Qv Qv il v
= O || &l BKPXXC2.cbl &
= S S W W R SR S SRS WS SS— S S S SN S R, S
FoEEUENM ApL B TOEY Pl1LE—WHELLIE JUUSULUY

MOVE 'RECORD ADDED' TO MESSAGES GO TC MENU.

* CHECK FIELDS ADDED/UPDATED
w
| CHECK.
T IF NAMEI = LOW-VALUES AND
ADDRI = LOW-VALUES AND
.
* ANY REQUIRED EDITING STEPS pUAmin mm suoonmen omnm
* L SUITRABLE FORM OF EDITING Undo
* RECORDS ARE PLACED ON THE F Revert File
* IS CALLED AS AN EXEMPLE, TO Save Ctrl+S
* CHARACTERS AND REPLACE THEM i
. <= Open Declaration F3
PHONET L Low_vALUES aND | *% Open Pe_r‘form Hierarchy Ctrl+Alt+H
DATET - LOW-VALUES AND Open With ‘
AMOUNTI | LOW-VALUES AND Show In Alt+Shift+W »
COMMENTI | LOW-VALUES cut Ctex
THEN MOVE 'RECORD NOT MODIF u d
&0 TO MENU. COpy [} Ctrl+C
* Paste Shift+Insert

The COBOL Editor’s “Block Selection” editing actions

® Block Copy works reasonably well when using the Assembler editor (see the Royal Cyber RDz Assembler Editing
course manual for the steps

e Sadly, Block Copy seems broken when it comes to the LPEX editing. We are discussing with the IBM development
team, and will let you know (via another Royal Cyber Newsletter) when things turn around.

® |n the meantime use the COBOL or PL/I editor for working with code blocks. This isn’t as bad as it sounds, because
starting with RDz v9 IBM provided an “Open With” Context menu option for switching editors on the fly.

3 @ver“sion 9.1.@ ;_‘MI :“T.wmjfl hy . *
k#*#######***##lﬂk pen Ferrorm Hierarchy ok 3k KK K|
IDENTIFICATION View ’
PROGRAM-ID. 'A Show In v
DATA DIVISION. [  Open With || & coBoL Editor N
WORKING-STORAGE | &) System z LPEX Editor
@1 WORD-BUF-1 p RunAs .
@1 WORD-BUF-2 P Debug As v| B Text Edltor_’
®1 CMPTMPA PIC Profile As v | E System Editor

The RDz editor’s Context Menu: Open With action
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5. When a job finished executing how can | get notified?
® Unfortunately, RDz doesn’t provide out-of-the-fox functionality for TSO Notify. There are two work-arounds:
i. Press F5 (refresh) or use the Context Menu to refresh your JES Filter

® Utilize the Poll Configuration option of “Show in Table” — to enable RDz’s automatic JES poll facility

s My Jobs 2
My Jobs
Resource Job ID Job Name Job Own.. Job Entr.. ReturnC.. ReturnIn.. Sy
@ DDS0001AJOBO.. JOBO6143 DDS000. DDS0001  2014/05. U0000 JCLERR...
@ DDS0001AJOBO.. JOB06140 DDS000.. DDS0001 2014/05.. U0000 JCLERR...
@ DDS0001LJOBOS.. JOB05797 DDS000.. DDS0001  2014/05.. U0000 NORMAL
@ DDS0001LJOBOS.. JOB05795 DDS000.. DDS0001  2014/05.. U0000 NORMAL
@ DDS0001LJOBOS.. JOB05792 DDS000. DDS0001  2014/05. UO00O NORMAL
@ DDS0001LJOBOS.. JOB05791 DDS000.. DDS0001  2014/05.. SOC7 ABENDed
s NNCNNAT L IMmDNC IMDNACT0N NNcnnn nNcann N1 A NG 1 1Annn AADAAAL
4 I
¥ Poll Configuration
7] Poll Wait Interval M 51s
“‘“" JES Polling

I. There is one additional option for this, though... an IBM consulting in Germany named: Dennis Behm
created a plug-in that essentially pushes LISTBC commands to your workstation. These commands include
TSO Notifications of Job completion.

ii. If you’re interested in more information about this, please check out this link:

https://www.ibm.com/developerworks/community/files/app/file/ | 80a95a0- | dc3-489f-9cf1-2899f55c0bf7 - and feel free

contact Dennis directly to obtain the plug-in: dennis.behm@de.ibm.com

6. How do | open multiple emulator sessions in version 9.x?

e From the menuy, select: Window > New Editor

Edit Navigate Search Project Run Ip

- & - o4 New Window Tl v v vy o | &, Manage Licenses | Quick Access B | [F- /05 Projects |&;
. |
l New Editor . 1
Hide Toolbam L
B Developmentdemomvs.hce & N { B Developmentdemomvs.hce &2
Open Perspective 4

Current host connection profile is: /Host( , Pmvs.hce Current host connection profile is: /HostConnectProjectFiles/Developmentdemomvs.hce

Show View

Customize Perspective...
Save Perspective As...
Reset Perspective...
Henu Utilities Co Close Perspective
Close All Perspectives

Navigation

Settings Preferences 5 User ID . : DDS@OO1
View Display source data or listings Time. . . ! 22:44
Edit Create or change source data Terminal. : 3278
Utilities Perform utility functions Screen. . i1
Foreground Interactive language processing Language. ! ENGLISH
Batch Submit job for language processing Rppl ID . : ISP
Command Enter TSO or Workstation commands TS0 logon : DBAUSER
Dialog Test  Perform dialog testing TS0 prefix: DDSEOO1
IBM Products 1IBM program products System ID : DEMOMVS
1 12345678

Please record your usage in the Demonstration Scheduler: . ¢ ISPF 7.1

>

> http.//demoworks.democentral.ibm.com/demoworks/schedule.php

>

The information you provide will assist with continuing our

support to the field sales force.

ADTOOLS BIRTHDAY/RETIREMENT SAMPLE APPLICATION

YYYYMHDD  <== PLERSE ENTER BIRTHDATE IN YYYYMMDD FOH

B < ENTER REQUEST
. SEE YOUR BIRTHDAY (LINK TO PROG
: CALCULATE RETIREMENT (CALL PROG
; CLEAR AND START OVER
! ABEND WITH SBc?

TN DU W~

Option ===>
F1=RETRIEVE F2=SPLIT F3=END F4=RETURMN F5=RFIND F6=RCHANGE

F3/F12/CLEAR TO TERMINATE, ENTER TO PROCESS
F7=UP F&=DOWN F9=SWAP F10=LEFT FL11=RIGHT F12=RETRIEVE

22/014
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7. Why does RDz Search take so long against large files and libraries (and what can |
do about it)?

e RDz’s Search — which is a premier value-add for the product - is done using Java on z/OS — and depending on the
volume of data to be searched over can be both expensive and time-consuming.
e Startingin RDz v9.1 IBM released a version of search called “Remote z/OS File Search”. This actually does a

standard ISRSUPC search on the host in the background (via JCL) — making it as fast as ISPF — and as inexpensive.
i. And additionally, this 9.1 Remote z/OS File Search still provides the terrific hyper-text linking back to the

dataset lines that caused search to test true for your text-pattern. ©

Rational Developer for System z

Search | Project Run Window Help

¥ Search.. Ci+H |5 v 35 v Q v Q
" File.. —_—
[® Remotez/OSFile.. [ | -
%7 Remote..

Text >

RDz v9.1 z/OS File Search

8. How can | save JES Spool files on z/OS (like the SDSF “XDC” command)?

e Using RDz v9.0 and earlier — you could save a JES Spool file to a local (workstation or network-server) dataset — by
utilizing the menu: File > Save As
i. However often you won’t be able to utilize a local file for your z/OS output because of binary values, or size,
or ... well ... it’s just not what you want to do — you want to save to a remote/zOS dataset.
e The good news is that in RDz v9.1 IBM has paved the way for you to do this because they’ve
i. Enabled Menu Manager actions on JES batch jobs and Spool Files (including nifty Menu Manager variables for
elements of the job (jobid, jobname, etc.)
ii. And they’ve provided sample REXX execs and Menu Manager scripts to write JES Spool files to remote z/OS
datasets
e In the next Newsletter we’ll discuss this topic (Menu Manager on JES Spool files) in-depth.

9. Does RDz support my COBOL 4GL? (IBM Report Writer, Netron Cap, CA Meta-
COBOL, Telon, etc.)

e From question #I| above — recall that RDz maintains an in-memory model of your program that is syntax-parsed, and
used for Content Assist, and all of the advanced COBOL, PL /I, JCL and Assembler tooling.
®  When you edit a 4GL source file (from some package that generates COBOL) the non-COBOL keywords embedded
in the file will give the in-memory parser fits (in other words you’ll see dozens to hundreds of syntax error
annotations and (most likely) your COBOL tooling will be disabled. &
e Preprocessing to the Rescue!
i. Since v8.0.3 RDz has provided an elegant and simple solution to this problem — called Preprocessor
Integration (see figure below).
ii. This option — part of your norm Property Group functionality - allows you to invoke a TSO REXX or CLIST
command — which invokes your 4GL preprocessor (which is part of your build JCL stream).
iii. The output of this preprocessing on the host is piped into the in-memory/parsed version of your code so
that the editor sees only ANSI-Standard COBOL
I. While you work with/edit the original 4GL source — just like using ISPF
e |IBM provides a learning/example video on this functionality — here:
https://www.ibm.com/developerworks/community/files/app/file/fb23df 1 b- 1f39-410d-afe6-898c9095a7e0
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=, COBOL Settings

Runtime Environments
Procedures and Steps
Local Compiler Options
Local Preprocessar
JCL Substitution
|| Editor Configurations|
Ty

Editor Configurations

~ Search libraries

Called program search libraries:

Set SYSLIB properties

~ Preprocessor Integration

Select which preprocessor configuration to use when identifying pre

() Use local preprocessors

@) Use remote preprocessors

~ Remote preprocessor configuration

REXX or CLIST invoking preprocessor:
DDSO001.TEST.REXX(RPTFRGND)

Preprocessor output location:
DDSO001.TESTL.COBOLQ

DDS50001

High-level gualifier for preprocessor data:

Preprocessor parameters:

Info | Categories |PL/I MFS | C/C++ BMSlCOBOLI Run | Assembler| JCL| zUnit| Link

RDz Property Group > COBOL tab > Editor Configurations > Remote Preprocessing setup

10.My SCM is not an IBM product and it’s not CA-Endevor... what are my options for

integration?

®  Assuming your SCM provides Check-in/Check-out, RDz can support it. Here are some options

SCM Solution

Serena/Changeman

Options

e Serena Plug-ins

e  Frameworks from:
o IBM
o Q-Group

Comments

Many customers choose Serena’s own RDz plug-ins, as they tend to
trust vendor-supplied solutions. However these can be pricey.
Consider contacting IBM or Q-Group to see what they offer:
http://qgrp.com/english/products/csar-for-changeman/

Panvalet, Librarian,
Alchemist, Home-
Grown SCM
products/utilities

e  Menu Manager, HATS
RCP
e CARMA

The best method for interfacing with these SCMs is to utilize IBM’s
own Menu Manager + HATS/RCP functionality.

Royal Cyber is arguably the best in the world at (cost-effectively)
assisting you with this work. Please check out our tutorial at:

http://webspherehatsguru.com/Royal-Cyber-Newsletter-Volume-2-
February-2014.pdf

ISPW

ISPW corporation’s own
plug-in to RDz

This is link to an ISPWV flyer:

www.interchip.de/filestorage/ISPWforMultiPlatformApplications.pdf
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The better answer to all of your “Say What?!?1” questions and comments

While the above are the most frequently asked questions they are by no means the only questions we get. In fact, in the 3 years we at
Royal Cyber have been doing RDz work we’ve compiled a large set of Frequently Asked Questions — which are free and available here:
http://royalcyber.com/em-app-store/rdz-extensible-eclipse-based-help-portal/

However you might ask yourself, “Why wait until an RDz question makes it into a Top 10 List”? Because, by the time that happens,
the question (and probably many other questions) has begun to drain your anticipated product productivity and lowered your
company’s return-on-investment.

Common Sense

And then the follow-on question (especially for management); If you’ve spent (22 How much ??) money on RDz software, and then spent
additional money (probably rivaling the software costs) on your people’s time installing, configuring and deploying RDz — wouldn’t it
make sense to get trained and mentored so that there’s minimal loss of productivity and users don’t find themselves going back to ISPF
because they don’t know how to do something using RDz?

We can help

RDz is Royal Cyber’s number one technical domain — and we are IBM’s premier RDz world-wide services provider. We specialize in
effective (including cost-effective) methods of getting ISPF developers up and running efficiently and we provide them with multi-layered
and easily consumable ‘how to’ technical services in creative packages such as:

e Our Distance Learning “Wrapper” program: http://royalcyber.com/em-app-store/rdz-distance-learning-wrapper-program/ -

that encloses our RDz Distance Learning with just enough technical mentoring and support for your custom RDz environment
e  Our extensive catalog of RDz products and services:
e  http://www.royalcyber.com/wp-content/uploads/2014/You-RDz-and-Royal-Cyber-v4.pdf

e Our Distance Learning program: http://royalcyber.com/royal-cyber-rdz-distance-learning-training-schedule/

where your developers will learn “native RDz” to the point that they’re both excited about using RDz and effective at using it.

Chris Leland: chris is Royal Cyber's primary RDz technical instructor - having worked full-time with RDz for
almost four years; developing applications in COBOL, feaching RDz classes and mentoring in COBOL and
Assembler, installing and configuring RDz, delivering custom workspace design sessions, writing an RDz evaluation
exam, and integrating RDz with Rational Asset Analyzer. Chris passed the IBM/RDz Certification exam with flying
colorsin 2011.
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Royal Cyber’s Rational EM “App Store”

One of the things that's difficult to do, when you provide many disparate solutions for the Rational space is to find
the proper software delivery strategy. So we built an App Store.

The “EM App Store” http://www.royalcyber.com/em-app-store/ is a web-based software distribution catalog that

</

Snippets

A plug-in that automates the creation and management of your Property A collection of COBOL, SQL, JCL, MVS Utiiity and Assembler code
Group SYSLIB function — critical to your RDz rollout success fragments with parameterized variables for quality reuse.

A collection of COBOL, SQL. JCL, A set of simple to sophisticated Plug-ins that extend RDz's Eclipse A set of our most popular

MVS Utility and Assembler RDz Regular Expressions, which can be il and JCL/Batch code review and RDz/Eclipse Workspace designs —
statement templates — Content used to simplify and accelerate standards checking functionality for [l from contemporary/Goth to Green-
Assist enabled. application analysis. run-time performance and maintain-Jill screen/Dino Both look & feel and

Shop allittle. If you see something like2 Pick it up.

n Facility

The Micro Focus COBOL Conversion tool allows customers to convert |BM Rational Host Access Transformation Services (HATS) transforms
Micro Focus COBOL source and copybooks to IBM compatible versions. traditional text-based Interfaces—such as 3270 and 5250 green-screen.

lobile

1BM Worklight helps you extend your business to mobile devices. It provides an open, flexible and comprehensive platform, upon which to build, run and
manage HTMLS, hybrid and native mobile apps.

This local Eclipse project provides fast, deep and Search-able, Check out our learning videos on RDz on RDz and RAA. Useful for
high-quality “How to" help on most aspects of RDz day-to-day use. post-training education and ongoing support

We offer deep technical services onjll We are setting up a 24-hour/RDz Using Menu Manager and Since IBM awarded Royal Cyber
both RDz and RAA. Our delivery Call Center, where you will be able HATS/RCP we have skeleton the delivery of their monthly

has gamered world-wide acclaim to screen-share and discuss your projects and deep expertise in this [l Distance Leamning program, we
from the over 40 companies we technical issues with a domain — critical to successful RDz [l have been offering short/custom
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provides a consolidated digital distribution platform
for the Royal Cyber Rational EM value-add plug-ins,
tools and specialty services for the Rational EM brand
solutions.

Some of the solutions can be automatically
downloaded and installed into Rational products.

Other solutions (typically the more complex offerings)
are blended tools + services.

We will continue to build out the various departments
and offerings from month-to-month.

In the meantime?

Stop by.
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Royal Cyber @ Innovate

We (Syed, Anand, Ravi, and Chris will be @ Innovate from Saturday thru Thursday. You can catch with any of us,
by emailing me (Syed Basheer): basheer@royalcyber.com - and we'll make the tfime to connect. We are

presenting at these sessions:

Session # Title Location Time

COBOL Application Development for IBM AIX Dolphin - Oceanic 2 Tue, 03-June

2210A
4:15 PM > 5:45 PM

1865A Aon Integramark Creates a Dynamic SOA Dolphin - Oceanic 2 Wed, 04 June

Envi t: L H
nvironement: Learn How 3:00 PM 9 4:00 PM

2434A Improving Your Time to Value with Rational System | Dolphin - Oceanic 1 Wed, 04-June

z Development Solutions: Proven Practices from the 10:45 AM > 12:15 PM

Pros

2339A Customer Panel: DevOps for Enterprise Systems: Oceanic 3 Tue, 03-June

Customer Success Stories 11:15 AM 5 12:15 PM

2331 Opening your Power Systems to Mobile Dolphin - Oceanic 2 Thursday, 05-June
3:00 PM = 4:00 PM

About Innovate 2014: http://www-01.iobm.com/software/rational/innovate/

|IBM Software

Innovate”?014

June 1-5 Orlando, Florida

o
.I
<Innovatee SPEED > o
U
Innovate Register Why Attend? Agenda Keynotes Sponsors Business Partners

Guest Speakers

Scott Adams, creator of the world renowned “Dilbert” comic strip, takes center stage at Innovate 2014.
Using his book, How to Fail at Aimost Everything and Still Win Big, as a backdrop, Adams will discuss
how all of us Dilberts can succeed in a world of pointy-haired managers. You don't want to miss his
inspiring story on how to Innovate@Speed.

Gene Kim is a multiple award-winning CTO, researcher and author. He was founder and CTO of
Tripwire for 13 years. Gene is a huge fan of IT operations, and how it can enable developers to
maximize throughput of features from "code complete” to "in production,” without causing chaos and
disruption to the IT environment.

Register to attend: https://www-950.ibm.com/events/wwe/innovate/inv | 4reg.nsf/enrollcodes?openform
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Royal Cyber in the News

In February & March we delivered our first two IBM RDz Distance Learning classes — to over 230 new RDz users
world-wide. As a first-time fransition from IBM, which had been running Distance Learning for six years there were
some hiccups with the logistics, but he results were as you can see below. By the fime this Newsletter goes to print
there will (likely) not be availability left in the April Distance Learning session, but you can sign up for May (through
the end of 2014) sessions here: http://royalcyber.com/royal-cyber-rdz-distance-learning-training-schedule/

Rational EM News

e For details on the Royal Cyber RDz Rollout and project/task usage modeling contact us:

ingquires@royalcyber.com

Table of Confents

RDz Education

1d RD: t Management
RDz Return-on-Investment — Web Seminar
o Setting up an in-house Self-Paced Learning Center - Workshop

RDz Product Add-ons and Utilities

sage, Img

o RDz Menu Manager Actions to MVS Utilities

Our services and deliverables are available for the following Dz
7.6, 8.0.1, 8.0.3, 8.5, 9.0 and 9.0.1.

o Details on RDz technical services:
http://www.royalcyber.com/wp-content/uploads/2014/You-
RDz-and-Royal-Cyber-v4.pdf

What people are saying
about Royal Cyber and our services

How did the RDz training work out for you?

e Very well. Incredible class.

® | enjoyed the classes and workshops a lot. | learned a lot about RDz and will use all that
| learned this week.

@ | liked the training and would gladly attend another session if given the opportunity. You
guys did a great job.

® The instructor was very knowledgeable and presented everything in a professional
manner and made sure we understood before he moved on.

® | was completely satisfied, great job.

What were the best aspects
of the Royal Cyber Rational education?

® The instructor was awesome!

® He obviously knows this tool inside and out and is talented at teaching others.
® His relaxed and approachable attitude encouraged much discussion and questions,
® The workshop slides “manual’ is an excellent reference — very detailed and clear.

® The instructor was very knowledgeable and did a good job with the challenging task of
lecturing via phone.

® The online chat-assistants were great because they could keep a running Q&A going,
answering questions without interrupting the flow.

@Copyright Royal Cyber, LLC
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